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Summary of major learning goals,

Course discussion and feedback
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Final exam

= Test structure, guidelines and rules
= Topics and example questions

= Exam preparation, discussion and open study

Introduction to Git & GitHub (+ website portfolios)


https://etherpad.wikimedia.org/p/bimm143_w22
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. https://bioboot.github.io/bimm143_W22/class-material/BIMM143_exam_guidlines.pdf

BIMM-143: INTRODUCTION TO BIOINFORMATICS
http://thegrantlab.org/bimm143

Preparing for the Final Exam

Overview: The final exam for BIMM-143 will be an open-book, open-notes 150-minute
test consisting of 33 questions.

Questions will be predominantly short answer (typically worth 2 points) with a number of
more involved longer answer questions (typically worth 5 points).

The number of points for each question is indicated at the beginning of each question.
There are 80 total points on offer.

There will be no questions covering the material from lecture 10 (the git version control
system). However, major points from all other lecture material are examinable



https://bioboot.github.io/bimm143_W22/class-material/BIMM143_exam_guidlines.pdf

Q1. Did you enjoy this course? (Rank in relation to others you have experienced at UCSD)?

Q2. Should this course be offered again?

Q3. If so what changes would you recommend for this course? (e.g. more/less DataCamp & Projects)
Q4. Was the course effectively organized (lecture and lab material online vs handout or Canvas site)?
Q5. What advice would you give to another student who is considering taking this course?

Q6. Considering both the limitations and possibilities of the subject matter and the course, how
would you rate the overall effectiveness of this course and instructor?

Q7. Do you agree or disagree - The course developed my abilities and skills for the subject?

Q8. On average, how many hours per week have you spent on this course, including attending
classes, doing homework's and assignments?

Q9. Any other comments you would like to share? EtherPad Link:

https://etherpad.wikimedia.org/p/bimm143 w22



https://etherpad.wikimedia.org/p/bimm143_w22

Thank you very much!




Bonus:

Bioinformatics & Genomics in Industry
Live Stram Video

Enjoy a set of short open ended guest lectures from leading genomic
scientists at lllumina Inc., Synthetic Genomics Inc., and the La Jolla

Institute for Allergy and Immunology. Feel free to contact these scientists
for networking and to have your questions about industry careers in
Bioinformatics and Genomics answered.



Bonus:
Introduction to Git & GitHub

Q} o1t




What Is Git”?

(1) An unpleasant or contemptible
person. Often incompetent,
annoying, senile, elderly or childish
N character.

(2) A modern distributed version °
control system with an emphasis 0 glt

on speed and data integrity.
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Version Control

Version control systems (VCS) record changes to
a file or set of files over time so that you can
recall specific versions later.

Free/open-source CVS (1986, 1990 in C) - CVSNT (1998) - QVCS Enterprise (1998) - Subversion (2000)

Software Change Manager (1970s) « Panvalet (1970s) - Endevor (1980s) * Dimensions CM
Client—server (1980s) - DSEE (1984) - Synergy (1990) - ClearCase (1992) - CMVC (1994) - Visual SourceSafe
Proprietary (1994) - Perforce (1995) + StarTeam (1995) « Integrity (2001) + Surround SCM (2002) -

AccuRev SCM (2002) - SourceAnywhere (2003) « Vault (2003) - Team Foundation Server (2005)
Team Concert (2008)

Free/open-source GNU arch (2001) - Darcs (2002) - DCVS (2002) - ArX (2003) - Monotone (2003) + SVK (2003)
Distributed Codeville (2005) - Bazaar (2005) « Git (2005) + Mercurial (2005) « Fossil (2007) -+ Veracity (2010)

Proprietary TeamWare (1990s7?) - Code Co-op (1997) - BitKeeper (1998) - Plastic SCM (2006)

There are many VCS available, see:
https://en.wikipedia.org/wiki/Revision_control



https://en.wikipedia.org/wiki/Revision_control

Client-Server vs Distributed VCS

g m collaborators

collaborators ‘\\;

with
commit access

/ code repository : E
AN i
g |

Client-server approach : Distributed approach

|

0 all collaborators
P : has a repository each

i

i

Distributed version control systems (DCVS) allows multiple people to work on a
given project without requiring them to share a common network.




THE #1 PROGRAMMER EXCUSE
FOR LEGITIMATELY SLACKING OFF:

“The Subversion server’s down”
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http://tinyurl.com/distributed-advantages

OH. CARRY ON.



http://tinyurl.com/distributed-advantages

Git 1Is now the most popular free VCS!

THE #1 PROGRAMMER EXCUSE - :
sl Git offers:
* Speed

“The Subversion server’s down”
HEY GETBAKY e Backups
. TOWORK: ,
|' 1 e Off-line access
e Small footprint
o SIMplicity”
» Soclal coding

SVN S down'7
\-

K

http://tinyurl.com/distributed-advantages

OH. CARRYON. ¥



http://tinyurl.com/distributed-advantages

Where did Git come from?

Written initially by Linus Torvalds to
support Linux kernel and OS
development.

Meant to be distributed, fast and more
natural.

Capable of handling large projects.

Now the most popular free VCS!







Why use Git?



Q. Would you write your Lab boolk in
pencil, then erase and overwrite Lk
every d&fj wikth new conbkenk?



Q. Would you write your Llab boolk in
pencil, then erase and overwrite Lk
every d&j wikth new conkenk?

Version control is the lab notebook of the digital
world: it's what professionals use to keep track of
what they've done and to collaborate with others.



Why use Git”

Provides ‘snapshots’ of your project during development and
orovides a full record of project history:.

Allows you to easily reproduce and rollback to past versions of
analysis and compare ditferences. (N.B. Helps fix software
regression bugs!)

Keeps track of changes to code you use from others such as
fixed bugs & new features

Provides a mechanism for sharing, updating and collaborating
(like a social network)

elps keep your work and software organized and available



Obtaining Git



: Note: You hopefully already have git installed! .
To check open the “Terminal” tab in RStudio and type

@whlch git
@ git --version

Obtaining Git




: Note: You might already have git installed .
To check open the “Terminal” tab in RStudio and type

@whlch git
@ git --version

Obtaining Git

Console Terminal R Markdown Jobs

~ © Terminall ~ class06

zico:class0b> which git
/usr/bin/git

zico:classPb> git --version

gLt version 2.30.1 (Apple G1t-130)
zico:class0o>




. Note: You might already have git installed :
To check open the “Terminal” tab in RStudio and type

(1)which git
@ git --version

Windows Only (if you have problems) . Mac Only (if you have problems) .
If the “which git” command did not work, try: | ' f the “which git” command did not work, you
where git .| may need to install select developer tools. '

. If this works see next slide. If not then you
. need to install GitBash, instructions here:

Class Computer Setup Page |  xcode-select --install

. In vour Terminal type:



https://git-scm.com/downloads
https://git-scm.com/downloads

On a PC Only!

Go to: RStudio > Tools > Global Options > Terminal

Options

General Shell Make sure
Code New terminals open with: Git Bash - Git Bash is
selected!

v Connect with WebSockets
Pane Layout

Miscellaneous

Packages . .
v Close terminal when shell exits

R Markdown

_ ? Using the RStudio terminal
W/~ Sweave

*%  Spelling

W Git/svn

/8 Publishing

. Terminal


https://bioboot.github.io/bggn213_S19/setup/
https://git-scm.com/downloads

5 Note: You might already have git installed :
- To check open the “Terminal” tab in RStudio and type:

(:>wh1ch git
(:>git --version

Wlndows (if you have problems)
. Follow the GitBash instructions here:

Class Computer Setup Page

Mac (if you have problems)
: ' In the Terminal instal select developer tools

xcode-select --install



Configuring Git



Configuring Git
(RStudio Terminal Tab)
(...or RStudio > Tools > Shell)

# First tell Git who you are
> git config --global user.name “Barry Grant”
> git config --global user.email “bjgrant@ucsd.edu”



Configuring RStudio



For Mac & Linux
(PC on next slide)

Go to: RStudio > Tools > Global Options > Git/SVN

Options

] Enable version control interface for RStudio projects 1 Ma ke Sure l‘h /S /S tiCked/

Git executable:

= 2 Make sure this Is correct!

SVN executable:
Jusr/bin/svn

eeeee

y earance
SSH RSA Key:

Console Terminal R Markdown

sing Version Control with RStudio

< | Terminal ¥~ another

blitz:angher> which git
/usr/local/bin/git
blitz:another>

Spelling

Cit/SVN




On a PC!

Go to: RStudio > Tools > Global Options > Git/SVN

Options

corerat v| Enable version control interface for RStudio projects 1 Ma ke Sure l‘h /S /S tiCked/
2 This is the PATH for PC!

Appearance SVN executable:
/

Pane Layout //Mac/Home/Documents Browse...

Packages SSH RSA Key:

= | bin

R Markdown

Create RSA Key...

./~ Sweave Home Share View

?’ Using Version Control with RStudio
ABC

. This PC » Local Disk (C:) »Program Files > Git > bin
v Spelling

A

Name Date modified Type

- ) 1 Documents
¥ Git/SVN

= Pictures e A A A A S
B bash /3/18 11:29 AV Applicati

¥~ I
8, Publishing iCloud Drive ( B git

- Terminal

Applicati
Dropbox (Mac ] sh /3/18 11:29 AM Applicati

m Desktop




Restart RStudio!






Using Git

1. Initiate a Git repository,
2. Edit content (ie. change some files).
3.5tore a ‘shapshot’ of the current file statex



Create a new Test
RStudio project

1 New option to create
a Git repository... 2 New Git tab. ..

AN

Create New Project Environment History Connections GE [
Directory name: . lef | Commit | | ’ | 9 ‘ O e :
. resl Staged Status Path
L\ Create project as subdirectory of: -
~ rowse... L] . . .gitignore

™ B B test.Rproj

Y| Create a git repository

L Use packrat with this project

Check if new Git options appear in RStudio?



Using Git in RStudio

1. Initiate a git repository for an RStudio Project
2. Do your work and edit content as normal

3. Store a ‘snapshot’ of the current file state
(a) Periodically add important files to git “Staging Area”

(b) Commit changes to your “git repository”

Rinse and repeat....






GitHub & Bitbucket

GitHub and Bitbucket are two popular hosting services for
Git repositories. These services allow you to share your
projects and collaborate with others using both ‘public’ and
private’ repositories™.

Pull requests Issues Gist

= U Bitbucket Dashboard ~ Teams ~ Find a repository... @) E
Dashboard

Overview Pull requests 1e Snippets
Filters: | All Watching Mine

New to Git?

& Grantlab / bio3d
Set up Git Fork repositories Work together

uide to help you get 5 are wher Forking new, unique Send pull requests, follow friends.
rted with Git. C ate on S project fr xisting one. Star and watch projects.

b ]

2-‘. larsss / cheminf

- https://bitbucket.orq

O bjgrant / test

- https://github.com =

View 59 new broat

remills pushed to gh-pages at bioboot/web-2015 ' .
% 207241 Merae branch ‘ah-pages' of httos://aithub.con ‘ e Your repositories ;g Memory problem while performing anal...
' A Issue #276 commented on in Grantlab/bio3d

Be

Al Public

] web-2015

3 commits
Pushed to Grantlab/bio3d
e5 Merge branch 'master’ into feature...

3bc Merge branch 'feature_aanma’ of ...
Merge branch 'master’ into feature...

3\ Subscribe to your news feed
@github

PuaTlal Fdd voie fond bacmdation blaa o wo seons follos amd vooanitovon swoss sokol



https://github.com
https://bitbucket.org

wsj.com

Nikkei Hang Seng US.10Yr Crude OIl Yen -
17893.73 0.49% 21404.96 0.72% -0/32 Yield 2.074% 39.17 -0.36% 119.16 0.26%

THE WALL STREET JOURNAL.  suronszveees

Home World U.S. Politics Economy Business Tech Markets Opinion Arts Life Real Estate Q
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YOU ARE READING A PREVIEW OF A PAID ARTICLE. IEITSH.TTI "M TO GET MORE GREAT CONTENT.
GitHub Raises $250 Million at $2 Billion
Valuation

Capital raise puts company’s total funding at $350 million

Analytics

How does your organization’s
talent measure up
to its technology?




D www.bbc.com/news/technology-44351214

Home Gmail Gcal Bitbucket GitHub BIMM143_F18 BGGN213_S18 BIMM-194 GDocs Disqus

B E O signin News Sport Weather Shop Reel Travel

NEWS

Home Video @ World US&Canada UK  Business Tech Science Stories

Microsoft buys Github code-sharing site
for $7.5bn

- Dave Lee
: ’ North America technology reporter

<«

® 4June 2018 K

X

News v Atmosphere Galaxy + v MMTF

Search

Entertainment & Arts Health

Top Stories

Gangster 'Whitey' Bulger killed in
prison
Bulger was severely beaten by one or

more inmates shortly after arriving at the
prison, sources say.

(© 30 October 2018

Synagogue shooting victims'
funerals start

(© 30 October 2018

What do American voters care
about?

(© 30 October 2018



What is the big deal?

* Atthe simplest level GitHub and Bitbucket offer backup of
your projects history and a centralized mechanism for
sharing with others by putting your Git repo online.

 GitHub In particular is often referred to as the "nerds
-~aceBook and Linkedln combined”.

* At their core both services offer a new paradigm for open
collaborative project development, particularly for software,

* |n essence they allow anybody to contribute to any public
project and get acknowledgment.




First sign up for a GitHub account
https://github.com

GitHub

Build software
better, together.

Powerful collaboration, code review, and code management for
open source and private projects. Public projects are always free.



https://github.com

PIcK the FREE plan!

Pull requests Issues Gist

Welcome to GitHub

You've taken your first step into a larger world, @biobootStudent.

Completed [[D Step 2:
Choose your plan

Set up a personal accoun

Choose your personal plan
Each plan includes:

Plan Cost Private repositories

Unlimited collaborators

Large $50/month 50 Choose o . o
Unlimited public repositories

Medium $22/month 20 Choose
Free setup

Small $12/month Choose HTTPS Protection
Email support
Micro $7/month Choose
Wikis, Issues, Pages, & more

$0/month

n US Dollars. Converted




Your GitHub homepage

Check your email for veritication request

‘ ’ Pull requests Issues Gist

Pro tip: updating your profile with your name, location, and a profile picture helps other
GitHub users get to know you.

Contributions Repositories ~ Public activity

Contributions

biobootStudent

Joined on Aug 26, 2015

0. 3

Starred

This is your contribution graph. When you make a commit to a repository, you'll get a = for that
day. Make more contributions and you’ll get a darker green square. Over time, your chart might
start looking something like this.

We have a quick guide that will show you how to create your first repository. You’ll also make a
commit and earn your first green square!

|zl Read the Hello World guide




Connecting RStudio to
GitHub

Create a Personal Access Token (PAT) on GitHub

See section 4 of lab worksheet



Skip the hello-world tutorial

https://quides.qgithub.com/activities/hello-world/

( ’ Pull requests Issues Gist

Your email was verified.

Learn Git and GitHub without any code!

biobootStudent ~ Your repositories

You don’t have any repositories yet!
Welcome to GitHub! What's next? Create your first re
a repository Git and GitHub.

g repositories

Follow @github on Twitter _ ,
ProTip! Feline cephalopod adhesives are great

for decorating portable computation devices.
~/ ProTip! Edit your feed by updating the users you follow and repositories you watch.

» Subscribe to your news feed



https://guides.github.com/activities/hello-world/

Name your repo
PDIMM 143

rstudio_test/... kebabs pack... Institute of B... bioconducto... BIMM-143, L... Create a Ne...

O Search GitHub Pull requests Issues Marketplace Explore A‘

Create a new repository

A repository contains all the files for your project, including the revision history.

Owner Repository name

. - . N
>

"% bioboot ~

Great repository names are short and memorable. Need inspiration? How about cuddly-invention.

Description (optional)

Public

Anyone can see this repository. You choose who can commit.

Private
You choose who can see and commit to this repository.

v| Initialize this repository with a README
R EAD M E @RS will let you immediately clone the repository to your computer. Skip this step if you're importing an existing repository.

Add .gitignore: None v Add alicense: None~ = ()

Create




Copy the “Clone” HTTPS lin

O This repository Search Pull requests Issues Marketplace Explore A 4~ v

bioboot / bimm143 @® Unwatch~ 1 Y Star 0O
<> Code Issues 0O Pull requests 0 Projects 0 Insights Settings

No description, website, or topics provided.

Add topics

D 1 commit I 1 branch © 0 releases 22 1 contributor

Branch: master v New pull request Create new file  Upload files @ Find filé Clone or download v

‘* bioboot Initial commit Clone with HTTPS ® Use SSH

©) README.md Initial commit Use Git or checkout with SVN using the web URL.

https://github.com/bioboot/bimm143.gilF EL

README.md

Open in Desktop Download ZIP

bggn213




RStudio > New Project > Version Control

New Project

Create Project

New Directory
Start a project in a brand new working directory

Existing Directory
Associate a project with an existing working directory

Version Control
Checkout a project from a version control repository

Cancel




RStudio > New Project > Version Control

New Project

Back

mn
O

Clone Git Repository

Repository URL: GitHub
https://github.com/bioboot/ bimm143.git Paste

Project directory name:
bimm143_github

Create project as subdirectory of:

~/Desktop/courses/ bimm143 Browse...

v Open in new session Create Project Cancel

T P WXV PRI AP P ETESN § O S ) W



Demo of editing, adding
committing ana pushing

Check if new Git tab
Appears in RStudio?

Environment History Connections GED

B piff Ml Commit | D | Iy - Now experiment editing the
Staged Status Path README.md file in RStudio
@ B B .gitignore and adding, committing and
B B W testRproj pushing changes to GitHub

via this tab




Demo of editing, adding
committing and pushing

Check if new Git tab
Appears in RStudio?

Environment

Staged Status

History Connections GED
B piff Ml Commit

Path
.gitignore
test.Rproj

|

Q| X -1

Now experiment editing the

README.md file in RStudio

and adding, committing and

pushing changes to GitHub
via this tab

When you are ready copy your
different class directories/projects
to this new GitHub tracked folder



Side-note: How to edit online

Specifically lets add some Markdown content

( > This repository Pull requests Issues

biobootStudent / demo1_github @ Unwatch~ 2  + Star

ch: master v demo1_github / README

biobootStudent \d Update README

9 lines (5 sloc) ©.236 kB Raw Blame History

# My first Git repo is now online
This is a first line of text.
This is a 2nd line of text.

I am going to use **markdown** syntax from now on because it is _cool!_
I am a student in [bioboot camp](http://bioboot.github.io/web-20815/)

Terms Privacy Security Contact Help Status APl Training Shop Blog About Pricing




summary

* (it is a popular ‘distributed’ version control
system that is lightweight and free

* GitHub and BitBucket are popular hosting
services for git repositories that have changed the
way people contribute to open source projects

* [ntroduced basic git and GitHub usage within
RStudio and encouraged you to adopt these ‘best
poractices’ for your future projects.



Bonus:
GitHub Spit & Polish
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bioboot/bimm143_serina_f18: Serina's Fall 2018 class repository fork Serina’s BIMM 143 Class Repository | Serina’s Bioinformatics Class (BIMM143,...

Introduction to
Bioinformatics

A demo site of students cool class web
site

View the Project on GitHub
bioboot/bimm143-1

This project is maintained by bioboot

Hosted on GitHub Pages — Theme by orderedlist

& bioboot.github.io/bimm143-1/ &

Bioinformatics Class

This is my repository for my Bioinformatics class from UC San Diego in S18.

Index of Material

Introductory Material: Working With R

Class 5 - Basic Data Exploration and Visualization in R HTML, MD, Rmd
Class 6 - Creating R Functions

Class 7 - R Packages, working with CRAN, and working with Bioconductor
Using R and Other Tools for Bioinformatics Analysis

Class 8 - An Introduction to Machine Learning (Heirarchical Clustering)
Class 9 - Analyzing High Dimensional Datasets and Unsupervised Learning

Class 11 - Structural Bioinformatics: Analyzing Protein Structure and
Function

Class 12 - Drug Discovery: Techniques and Analysis

Class 13 - Genome Informatics and High Throughput Sequencing (NGS,
RNA-Seq, and FastQC)

Class 14 - Transcriptomics and RNA-Seq Analysis

Bioinformatics Class BIMM-143 | Introduction to Bioinformatics (BIMM143)

_*_



In your web browser navigate to your GitHub class repository < https://github.com/ >

Side-note:
To find the link to your GitHub repository from RStudio, open one of your past class
projects and in the terminal type:

git remote -v

@ GitHub, Inc. github.com/bioboot/bimm143_fall18 &

Pull requests Issues Marketplace Explore

L) bioboot / bimm143_fall18 © Unwatch~ 1 wstar 0  ¥Fork 0
<> Code Issues 0 Pull requests 0 Projects 0 Wiki Insights Settings
My class repo for bimm143 at UCSD Edit

Manage topics

D 22 commits ¥ 1 branch © O releases 22 1 contributor
Branch: master v New pull request Create new file  Upload files = Find file Clone or download ¥
. bioboot Add class18 Latest commit 959723b 7 minutes ago
BB class05 Add class 5 a month ago

B class08 add class08 a month ago


https://github.com/

Or for a given GitHub tracked file click G!T/| icon and "VIEW on GITHUB"

] - € & - BB @ A Go tofile/function | 5 -~ &8 - Addins -~ £} class18 — bggn213_github -

=) Untitled1* =) lecture18_part2_example.Rmd B sut & Diff "lecturel8part2example.Rmd" gl . Environment  History  Conrrecti
& A E e </ Knit - &% - Log of "lecturel8part2example.Rmd" | = & ™ & Import Dataset - «
i . Revert "lecturel8part2example.Rmd"... i, Global Environment ~ '@
70~~~ {r} — - . - o il (-
val View "lecturel8part2example.Rmd" on GitHub L3 £ 3
: . Blame "lecturel8part2example.Rmd" on GitHub - OSeqs 1st o Q
72 write.fasta(seqs=store.seqgs, 1ids _ W, sto.. chr [1:4.. M
&! Commit... XM
Values
74 "~ & Pull Branches 4 24
e N end.. num [1:4] ..
1 4l
/0 © History Fil Plots Packages _Heip
iles ots acka
| : In n :
;Z ## Sidenote put sequence setu g» project Setup... - e
. @ 213_github > class18 E¥ ..
7’9 For refernce only, here we use the UniProt KRas oncogene sequence e
Chdedne / /iananar 1mannad+t Ana/Ziinat nna+ /IDA11168\ Ac An avAamnla 1 nnii+ And maAalba A t
53:1 @ Chunk6 3 R Markdown =
Console Terminal R Markdown - = : ﬁ class18.Rproj
In.f
~/Desktop/courses/bggn213_W19/bggn213_github/class18/ = / ain.ta
R213V nYu nLn nDu nDn nRu nNn nTu "Fn ||Vll "Hn nsu nvu uV" . "'3 Iecture18_part2_exa...
D259V uIn IILII uTu IIIII nIu IITII uLu IIEII uVu nm_n nm_n n_n nown . . subsequences.fa
® B kras-sequences.fa
[,14]1 [,15] [,16] [,17] 2 )
D41L "S" npn np n"p" ) lecture18_part2_exa...
® B segs.fasta

R6SW "A"  "P"  "P"  "V"
R213V "V"  "P" "Y'  "E"
D259V "-"  romoomormowlw
>




Repository Settings

Head over to your GitHub class repository (where you are “pushing” all your class work)

Click on the Settings tab.
Pull requests Issues Gist A -+~ g v
® Watch~y r 0 YFork O
aquests 0 Projects 0 Wiki Pulse Graphs SEttingS

Edit

I 1 branch O 0 releases 22 1 contributor



Theme chooser

Scroll down to the GitHub Pages section.fsess-Gheeose-a-theme—
And set the Source to “main branch"

GitHub Pages

GitHub Pages is designed to host your personal, organization, or project pages from a GitHub repository.

Source

GitHub Pages is currently disabled. Select a source below to enable GitHub Pages for this repository. Learn more.

None ~

Theme chooser
Select a theme to build your site with a Jekyll theme using the master branch. Learn more.

Choose a theme



Pick a theme

Choose one of the themes from the carousel at the top.

When you're done, click Select theme on the right.

O This repository Pull requests Issues Gist

@

Time
Machine

Hide thumbnails

View on GitHub @

Slate theme

Slate is a theme for GitHub Pages.




Side-note:

Scroll down again to the GitHub Pages section to find the link to your new website.
Open this link in a New Tab of your browser:

GitHub Pages

GitHub Pages is designed to host your personal, organization, or project pages from a GitHub repository.

Source
Your GitHub Pages site is currently being built from the master branch. Learn more.

master branch ~ Save

Theme Chooser
Select a theme to publish your site with a Jekyll theme. Learn more.

Your site is currently using the Minimal theme.

Change theme



Back on the repository main page use the GitHub online editor to add content.

Edit content

In particular, add links to each classes .MD file

jldec / new-pages-site ®@Watchv 0  Star 0  ¥Fork

<> Code Issues 0 Pull requests 0 Projects 0 WiKi Pulse Graphs Settings
new-pages-site / README.md E*  or cancel

<> Edit file ® Preview changes Spaces % 2 &  Softwrap

[

2

O 00 N O

10
11
12
13
14

## Welcome to GitHub Pages

You can use the [editor on GitHub](https://github.com/jldec/new-pages-site/edit/master/README.md) to maintain and preview the content
for your website in Markdown files.

Whenever you commit to this repository, GitHub Pages will run [Jekyll](https://jekyllrb.com/) to rebuild the pages in your site, from
the content in your Markdown files.

### Markdown
Markdown is a lightweight and easy-to-use syntax for styling your writing. It includes conventions for

" “markdown
Syntax highlighted code block

# Header 1

=
v

0



Commit
Enter a commit comment and click on Commit changes below the editor.

25  ### Support or Contact
36

37 Having trouble with Pages? Check out our [documentation](https://help.github.com/categories/gi
(https://github.com/contact) and we’ll help you sort it out.

38

E Commit changes

‘ Add content to new pages site|

© o Commit directly to the master branch.

Odn — - 1 1 -



...and you re done!

Fire up a browser and go to http://username.github.io/repository.

v
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& bioboot.github.io/bimm143-1/ &

bioboot/bimm143_serina_f18: Serina's Fall 2018 class repository fork Serina’s BIMM 143 Class Repository | Serina’s Bioinformatics Class (BIMM143,... Bioinformatics Class BIMM-143 | Introduction to Bioinformatics (BIMM143) —+

Introduction to Bioinformatics Class
Bioinformatics

This is my repository for my Bioinformatics class from UC San Diego in S18.
Index of Material

Introductory Material: Working With R

Class 5 - Basic Data Exploration and Visualization in R HTML, MD, Rmd
Class 6 - Creating R Functions

Class 7 - R Packages, working with CRAN, and working with Bioconductor
Using R and Other Tools for Bioinformatics Analysis

Class 8 - An Introduction to Machine Learning (Heirarchical Clustering)

A demo site of students cool class web Class 9 - Analyzing High Dimensional Datasets and Unsupervised Learning

Site
Class 11 - Structural Bioinformatics: Analyzing Protein Structure and
View the Project on GitHub Function
bioboot/bimm143-1

Class 12 - Drug Discovery: Techniques and Analysis
This project is maintained by bioboot

Class 13 - Genome Informatics and High Throughput Sequencing (NGS,
Hosted on GitHub Pages — Theme by orderedlist RNA-Seq, and FastQC)

Class 14 - Transcriptomics and RNA-Seq Analysis

Here I: (1) forked Serina’s Repo, (2) Chose the “minimal” theme, (3) Edited _config.yml (adding logo and title)



¥ bioboot / bimm143_serina_f18 ®Ounwatch 1  %sStar 0  YFork 1

forked from serinahuang/bimm143

<> Code ') Pull requests 0 "Il Projects 0 == Wiki ‘Insights Settings
Branch: master v bimm143_serina_f18 / _config.yml Find file = Copy path
,% bioboot Update _config.yml 3b72493 just now

1 contributor

4 lines (3 sloc) 151 Bytes Raw Blame  History 0 2 M

theme: jekyll-theme-minimal
logo: https://bioboot.github.io/bimm143_F18/assets/img/logo.png
title: Serina's Bioinformatics Class (BIMM143, Fall 2018)

Here I: (1) Chose the “minimal” theme, | (3) Edited config.yml (adding logo and title), | (4) Edited README.md




@00 < > @O https://bioboot.github.io/bggn213/ ©O & O |m

Foundations of BGGN213
Bioinformatics
Class S18

This is my classwork from BGGN213 at UC San Diego (S18). The main class
homepage is here

e Class05: Data Visualization in R (for other self contained formats see
HTML, MD and R).

e (Class06: Why, when and how of writing your own R functions

e (Class07: Bioinformatics R packages from CRAN and BioConductor
e Class08: Machine Learning for Bioinformatics 1

e Class09: Machine learning project

e [Etc.

A demo site of students cool class work
portfolio

View the Project on GitHub
bioboot/bggn213

Here I: (1) Chose the “minimal” theme, (3) Edited _config.yml (adding logo and title), (4) Edited README.md

https://bioboot.github.io/tmp test/



https://bioboot.github.io/bggn213/
https://bioboot.github.io/tmp_test/

/\
il

& bioboot.github.io/bimm143-1/ &

bioboot/bimm143_serina_f18: Serina's Fall 2018 class repository fork Serina’s BIMM 143 Class Repository | Serina’s Bioinformatics Class (BIMM143,... Bioinformatics Class BIMM-143 | Introduction to Bioinformatics (BIMM143) —+

Introduction to Bioinformatics Class
Bioinformatics

This is my repository for my Bioinformatics class from UC San Diego in S18.

Index of Material

Introductory Material: Working With R

Class 5 - Basic Data Exploration and Visualization in R HTML, MD, Rmd
Class 6 - Creating R Functions

Class 7 - R Packages, working with CRAN, and working with Bioconductor
Using R and Other Tools for Bioinformatics Analysis

Class 8 - An Introduction to Machine Learning (Heirarchical Clustering)

A demo site of students cool class web Class 9 - Analyzing High Dimensional Datasets and Unsupervised Learning

Site

Class 11 - Structural Bioinformatics: Analyzing Protein Structure and
View the Project on GitHub Function

bioboot/bimm143-1

Class 12 - Drug Discovery: Techniques and Analysis

This project is maintained by bioboot

Class 13 - Genome Informatics and High Throughput Sequencing (NGS,
Hosted on GitHub Pages — Theme by orderedlist RNA-Seq, and FastQC)

Class 14 - Transcriptomics and RNA-Seq Analysis

Here I: (1) Chose the “minimal” theme, | (3) Edited _config.yml (adding logo and title),| (4) Edited README.md



bioboot / tmp_test ®© Unwatch~v 1 W Star 0 ¥Fork ©

<> Code Issues 0 Pull requests 0 Projects 0 Wiki Insights Settings
tmp_test / README.md E¢  orcancel

<> Edit file © Preview changes Spaces % 2 & Softwrap %
1  # BIMM143 Classwork
2
3 This is a store of my class-work for [BIMM143 Winter 2019](https://bioboot.github.io/bimm143_W19/) at UC San Diego.
4
5 ## Content
6 - Class05: [R fundamentals](https://github.com/bioboot/tmp_test/blob/master/class@5/class@5.md)
7 - Class06: [R graphics]()
8 —= Class@7: R Functions
9 - Class@8: R packages from CRAN, Bioconductor and GitHub

10 - Class@9: Introduction to machine learning

11— Class10: Some thing else

12— Classll: (Structural Bioinformatics] (https://github.com/bioboot/tmp_test/blob/master/classll/classll.md)
13— Classl2: etc. etc.

14

Here I: (1) Chose the “minimal” theme, (3) Edited _config.yml (adding logo and title), | (4) Edited README.md
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& bioboot.github.io/bimm143-1/ &

bioboot/bimm143_serina_f18: Serina's Fall 2018 class repository fork Serina’s BIMM 143 Class Repository | Serina’s Bioinformatics Class (BIMM143,... Bioinformatics Class BIMM-143 | Introduction to Bioinformatics (BIMM143) —+

Introduction to Bioinformatics Class
Bioinformatics

This is my repository for my Bioinformatics class from UC San Diego in S18.

Index of Material

Introductory Material: Working With R

Class 5 - Basic Data Exploration and Visualization in R HTML, MD, Rmd
Class 6 - Creating R Functions

Class 7 - R Packages, working with CRAN, and working with Bioconductor
Using R and Other Tools for Bioinformatics Analysis

Class 8 - An Introduction to Machine Learning (Heirarchical Clustering)

A demo site of students cool class web Class 9 - Analyzing High Dimensional Datasets and Unsupervised Learning

Site
Class 11 - Structural Bioinformatics: Analyzing Protein Structure and
View the Project on GitHub Function
bioboot/bimm143-1

Class 12 - Drug Discovery: Techniques and Analysis
This project is maintained by bioboot

Class 13 - Genome Informatics and High Throughput Sequencing (NGS,
Hosted on GitHub Pages — Theme by orderedlist RNA-Seq, and FastQC)

Class 14 - Transcriptomics and RNA-Seq Analysis

Here I: (1) forked Serina’s Repo, (2) Chose the “minimal” theme, |(3) Edited _config.yml (adding logo and title)




Thank you very much!

Please do fill out your CAPs evaluation ( Link! ) if you get a change.
It is important to the courses we offer in the future and how we teach them!



https://academicaffairs.ucsd.edu/Modules/Evals?e4900527

Thank you very much!

Please do fill out your CAPs evaluation ( Link! ) if you get a change.
It is important to the courses we offer in the future and how we teach them!



https://academicaffairs.ucsd.edu/Modules/Evals?e4900527

Going Further With DataCamp

https://bioboot.github.io/bimm143 F19/class-material/datacamp extras.pdf

www.datacamp.com/tracks/custom-bioinformatics-extension &

(O What would you like to learn t Learnv  Practice  Projects Pricing My Classes 3,050 XP ‘ v %

CUSTOM TRACK

Bioinformatics Extension

Barry's suggested DataCamp courses for delving deeper into R, Git, the Shell, data
visualization, and Bioinformatics data analysis generally. Please do reach out if you

encounter problems. Happy DataCamping!

Enroll

R RLanguage | Shell | Git | Spreadsheets | © 111hours | 26 Courses

INSTRUCTORS

Introduction to Shell for Data ‘? Greg Wilson

Science Co-founder of Software

Carpentry

The Unix command line helps users combine existing programs
INn new wavs. automate repetitive tasks. and run programs ... N =

Jonathan Cornelissen



https://bioboot.github.io/bimm143_F19/class-material/datacamp_extras.pdf

Thank you very much!

Please do fill out your CAPs evaluation ( Link! ) if you get a change.
It is important to the courses we offer in the future and how we teach them!



https://academicaffairs.ucsd.edu/Modules/Evals?e4900527

Bonus:

Bioinformatics & Genomics in Industry
Live Stram Video

Enjoy a set of short open ended guest lectures from leading genomic
scientists at lllumina Inc., Synthetic Genomics Inc., and the La Jolla

Institute for Allergy and Immunology. Feel free to contact these scientists
for networking and to have your questions about industry careers in
Bioinformatics and Genomics answered.



|_earning Resources

Set up Git. If you will be using Git mostly or entirely via
GitHub, look at these how-tos.
< https://help.qgithub.com/categories/bootcamp/ >

Getting Git Right. Excellent Bitbucket git tutorials
< https://www.atlassian.com/qit/ >

Pro Git. A complete, book-length guide and reference to Git,
by Scott Chacon and Ben Straub.
< http://qit-scm.com/book/en/v2 >

StackOverflow. Excellent programming and developer Q&A.
< http://stackoverflow.com/questions/tagged/qgit >



https://help.github.com/categories/bootcamp/
https://www.atlassian.com/git/
http://git-scm.com/book/en/v2
http://stackoverflow.com/questions/tagged/git

|_earning git can be painful!

However In practice it Is not nearly as crazy-making as

the alterna

e Docum

e Halir-ral

Ves:
ents as emaill attachments

sing ZIP archives containing tile salao

« Am | working with the most recent data”

e Archae

logical "digs” on old emall threads and

uncertainty about how/if certain changes have been
made or issues solved



Finally Please remember that GitHub

and BitBucket are PUBLIC and that

you should cultivate your professional
and scholarly profile with intention!
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Reference Slides

Command Line GIT



Using Command Line Git

1. Initiate a Git repository,
2. EAit content (i.e. change some files).
3. Store a ‘smapsko%’ of the current file stabe.x



Initiate a Git repository



Initiate a Git repository

> cd ~/Desktop

> mkdir git_class # Make a new directory

> cd git_class # Change to this directory
> git init # Our first Git command!
> |S -a # what happened?



Side-Note: The .git/ directory

Git created a ‘hidden’ .git/ directory inside your
current working directory.

You can use the ‘Is =a’ command to list (1.e. see)
this directory and its contents.

This is where Git stores all its goodies - this Is
Git!

You should not need to edit the contents of the .git
directory tor now but do feel free to poke around.



Important Git COmmands

re,oorz‘ on com‘enz‘ changes

SN S S SN R AR ¥

M AR A R ST A S AR BN AP AN ST IR EPEAPIS,

g S glt ‘add <f|\ename> #sz‘age/tracka file
eIl commlt -mM message #snapshoz‘

Lﬁ-w. SRR S AT R B R R %" e STt S . e s D S NS S SRS S

e e e e e ‘:ﬂw

|

Bp— —n




Important Git COmmands

#re,oorz‘ on com‘ent changes

. —— - _

BN AP AN ST IR EPEAPIS,

> git add <fi\ename> P sz‘age/track afile
> glt commlt -M message #snapshot

S S e S s e

You Wl// use these z‘hree commands again and again in your G/z‘ Workf/owl




Git TRACKS your directory content

'+ To get a report of changes (since last commit) use: l
> git status |
- Youtell Git which files to track with: |
. > git add <filename> !
. This adds files to a so called STAGING AREA |
~ (akin to a "shopping cart” before purchasing). ’

'+ You tell Git when to take an historical SNAPSHOT of |
| yaur staged files (1 e record thelr current state) with: |

> git commit -m ‘Your message about changes’

ST s SIS e s i S A R R R O R S e i agls = SRR s Wi e S AN J




Example Git workflow

Eva creates a README text file
(this starts as untracked)

Commit changes”®
(records snapshot of staged files!)

Adds file to STAGING AREA*
(tracked and ready to take a snapshot)




Example Git workflow

“va creates a README text file

Adds file to STAGING AREA*

Commit changes®

—va modifies README and adds a ToDo text file _’

Adds both to STAGING AREA*




1. Eva creates a README file

> # cd ~/Desktop/git_class

> # git init

> echo "This is a first line of text." > README
> git status # Report on changes

# On branch master |

# Initial commit

... to include in what will be committed)

# README

#
# nothing added to commit but untracked files present (use "git add" to track)



2. Adds to ‘staging area

> git add README  # Add README file to staging area
> git status # Report on changes

# On branch master
#
# Initial commit

# —(Usegit T =cached <fite>..." to unstage)

#
# newfile: README
#



3. Commit changes

> git commit -m “Create a README file” # Take snapshot
# [master (root-commit) 8676840] Create a README file

# 1 file changed, 1 insertion(+)
# create mode 100644 README

> git status # Report on changes

# On branch master
# nothing to commit, working directory clean



4. Eva modifies README file
and adds a ToDo file

> echo "This is a 2nd line of text." >> README
> echo "Learn git basics" >> ToDo

> git status # Report on changes

# On branch master
#
# Changes not staged for commit:
# (use "git add <file>..." to update what will be committed)
(use "git checkout -- <file>..." to discard changes in working directory)

modified:

#

#

#

#

# Untracked files:
# (use "git add <tile>..." to include in what will be committed)
#

#

#

#

no changes added to commit (use "git add" and/or "git commit -a")



5. Adds both files to ‘'staging area’

> git add README ToDo # Add both files to ‘staging area’
> git status # Report on changes

# On branch master
# Changes to be committed:
# (use "git reset HEAD <file>..." to unstage)

modified: README
new file: ToDo

H H H H



6. Commits changes

> git commit -m "Add ToDo and modify README"

# [master 7b679fa] Add ToDo and modity README
# 2 files changed, 2 insertions(+)
# create mode 100644 ToDo

> git status

# On branch master
# nothing to commit, working directory clean



Example Git workflow

1. Cva creates a README text file
2. Adds file to STAGING AREA~
3. Commit changes*

N\

—va modifies README and adds a ToDo text file

Adds both to STAGING AREA*

Commit changes™

4.
0.
0.

...But, how do we see the history of our project changes?



git log: Timeline history of
snapshots (/.e. commits)

> git log

# commit 7bo79fa’747e8640918fcaad/7e4c3t9¢c70c87b170
# Author: Barry Grant <bjgrant@umich.edu>

# Date: Thu Jul 30 11:43:40 2015 -0400

#

# Add ToDo and finished README

#

# commit 867684016107 70ae32e2td4taee0/7d1d5¢c68619¢
# Author: Barry Grant <bjgrant@umich.edu>

# Date: Thu Jul 30 11:26:40 2015 -0400

#

# Create a README file

#



git log: Timeline history of
snapshots (/.e. commits)

> git log

# commit 7bo79fa’747e8640918fcaad/7e4c3t9¢c70c87b170
# Author: Barry Grant <bjgrant@umich.edu>

# Date: Thu Jul 30 11:43:40 2015 -0400

H

# Add ToDo and finished README

#

# commit 867684016107 70ae32e2td4taee0/7d1d5¢c68619¢
# Author: Barry Grant <bjgrant@umich.edu>

# Date: Thu Jul 30 11:26:40 2015 -0400

H

# Create a README file

# Past




Side-Note: Git history Is akin
to a grapnh

Nodes are commits labeled by their
| unique ‘commit ID’.

3 (This is a CHECKSUM of the commits |
~author, time, commit msg, commit content |
[ and previous commit ID). |

e e S A S e DS e e S e e i R R

> - 2 AP DS e IR NG s

"HEAD is a reference (or ‘pointer’) (o the.
i currently checked out commit (typically the
most recent commit). |

PRI

L‘TM

Time



Projects can have complicateo
grapns due to branching

Master Feature

7:7. : SIX2 @

| 6.

| Branches allow you to work independently

199K...

of other lines of development we will talk
more about these later!



Key Points:

You explicitly and iteratively tell git what tiles to
track (“git add”) and snapshot (“git commit”).

Git keeps an historical log “(git log”) of the
content changes (and your comments on these
changes) at each past commit.

't IS good practice to regularly check the status
of your working directory, staging arena repo
(“git status”)



Break



Summary of key Git commands:

TR FENSNG AR P AP e R SO RSN AP P : e

; > git status # Get a status report of Changes since Iast commit

S SO Rt SRS R R AR S S SRtk R T R e R Y R e e i R e SR T S IR e SRR ROAE ¥

B S Y AR R S T e N N R G P B A B S N S A S S A S O S R S A e SR

r> git add <filename> # Tell Git which files to traok/stage |

e glt commlt -m ‘Your message # Take a content snapshot'

O R AR

AR TR fad ol e BN ASAPII A INAE S e

; > git IOg # Rewew your commit hlstory

. PR . PSP AN oo TSR A AN i . ORI DA o oo g ot - A A S O R AU AR A A SO TR N AP E e L A AP AN LIRS Vg YISy S AR A Toms E e Gd iabca oo %

[> git dlff <comm|t ID> <commit.ID> # Inspect content differences |

: > glt checkout <commit.ID> # Navigate through the commit history

ST Lo e s e s e s e e S e R O e R S IR O R A T I TR S TR DO R SR e s IR R SR At SRS J




Your 'Staging
Directory  Area’

status

ff <

Local
Repository

log



git diff: Show changes
petween commits

> git diff 8676 7b67

# diff --git a/README b/README

# index 73bc85a..67bd82¢c 100644
# --- a/README

# +++ b/README

@@ -1+1,2 @@

# Thisis a first line of text.

# +This is a 2nd line of text.

# diff --git a/ToDo b/ToDo
# new file mode 100644

# index 0000000..14fbd56
# --- /dev/null

# +++ b/ToDo

# @@ -0,0 +1 @@

# +Learn git basics




git diff: Show changes
petween commits

~ git diff 7b67 8676

# diff --git a/README b/README

# Index 6/bd82c..73bc85a 100644
# --- a/README

# +++ b/README

#@@-1,2 +1 @@

# This is a first line of text.

#

# diff --git a/ToDo b/ToDo

# deleted file mode 100644
# index 14tbd56..0000000
# --- a/loDo

# +++ /dev/null

#@@ 1+0,0 @@

#




git diff: Show changes

between commits
# Index 73bc85a..07bd82¢c 100644
¥ Q@ -1 +1.2 Q@ 7‘7
# +++ b/ToDo

> git diff 8676 ## Difference to current HEAD position!
# diff --git a/README b/README

# --- a/README ?

# +++ b/README

# This Is a first line of text.

# +This is a 2nd line of text.

# diff --git a/ToDo b/ToDo

# new file mode 100644

# Index 0000000..14tbdb56

# --- /dev/null

¥ @@ -00 +1 @@

# +Learn git basics



HEAD aadvances automatically with
each new commit

?
HEAD gi{ _

/ To move HEAD (back or forward)

on the Git graph (and retrieve the
associated snapshot content) we
can use the command;

I > git checkout <commit.ID>




git checkout: Moves HEAD

> more README
This is a first line of text.
This is a 2nd line of text.

> git log --oneline m 7‘
# 7bo679fa Add ToDo and finished README

# 8676840 Create a README file |

7




git checkout: Moves HEAD
(e.g. back in time)

> more README
This is a first line of text.
This is a 2nd line of text.

> git log --oneline
# 7bo679fa Add ToDo and finished README
# 86/6840 Create a README file

RS O RGP e o e o e

= git checkout 86768
| # You are in 'detached HEAD' state...<cut>...
f # HEAD is now at 8676840... Create a README file

Mok i L

"~ more README
This Is a first line of text.

> git log --oneline
# 86/6840 Create a README file



git checkout: Moves HEAD
(e.g. back to the future!)

> git checkout master
# Previous HEAD position was 8676840... Create a README file

# Switched to branch 'master’

> git log --oneline m 7‘
# 7b679fa Add ToDo and finished README

# 8676840 Create a README file |

7

> more README
This Is a first line of text.
This Is a 2nd line of text.




Side-Note: There are two™ main ways to
use git checkout

* Checking out a commit makes the entire working
directory match that commit. This can be used to
view an old state of your project.

> git checkout <commit.ID>

* Checking out a specific file lets you see an old
version of that particular file, leaving the rest of
your working directory untouched.

> git checkout <commit.ID> <filename>



You can discard revisions
with git revert

* [he git revert command undoes a committed
snapshot.

* But, instead of removing the commit from the
poroject history, it figures out how to undo the
changes introduced by the commit and appends

a hew commit with the resulting content.

> git revert <commit.|D>

* This prevents Git from losing history!



Removing untracked files

with git clean

* The git clean command removes untracked files from
your working directory.

e Like an ordinary rm command, git clean is not
undoable, so make sure you really want to delete the
untracked files before you run it.

> git clean -n

> git clean -f

dry run display of files to be ‘cleaned’

remove untracked files



GUIs

Tower (Mac only)
GitHub_Desktop (Mac, Windows)
SourceTree (Mac, Windows)
SmartGit (Linux)
RStudio

https://git-scm.com/downloads/quis



https://git-scm.com/downloads/guis

